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Typographic Conventions

Table 1

N

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

Www.sap.com

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 Hyperlink to an SAP Note, for example, SAP Note 123456
Example e  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® (Cross-references to other documentation or published works
Example ®  Qutput onthe screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the
latest version on the SAP Help Portal at help.sap.com/bosm101.

The following table provides an overview on the most important document changes:

Table 2
1.0 2014-02-28 Initial version
11 2014-10-23 In the topics Installing Application Server on a Microsoft Windows Server [page 15] and
Installing Application Server on a Linux/UNIX Server [page 16], added a step you must
perform if your NetWeaver system database is something other than Max DB.
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1 Introduction

11 About This Document

Use this guide to learn how to upgrade from one support package level to another within the 10.1 series of SAP
Strategy Management.

This document contains the following sections:
®  Planning
® Preparation
® Upgrade Process

®  Follow-up Activities

1 Note

The central starting point for the technical implementation of your SAP solution is the Master Guide, which
you can find on the SAP Help Portal at help.sap.com/bosm101.

1 Note

You can find the most current information about the technical upgrade of the strategy management application
and the latest upgrade, installation, and configuration guides on the SAP Help Portal at help.sap.com/bosm101.

We strongly recommend that you use the documents available here. The guides are regularly updated.

Constraints

To learn how to upgrade the Excel Add-In client program, refer to the Client Installation Guide for SAP Strategy
Management Excel Add-In on the SAP Help Portal at help.sap.com/bosm101.

1.2 Naming Conventions

In this documentation, the following naming conventions apply:

Table 3

<nw_server>:<port> Server name or IP address and port where SAP NetWeaver is installed and

strategy management application components are deployed

CUSTOMER
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1.3 Related Information

Planning Information

For more information about planning topics not covered in this guide, see the following content:

Table 4
Latest versions of installation and upgrade guides SAP Help Portal at help.sap.com/bosm101
Network security SAP Help Portal at help.sap.com/bosm101
System requirements and supported platforms On SAP Service Marketplace, see Product Availability Matrix
(PAM) at service.sap.com/pam. Then search on strategy
management.

1.4 Further Useful Links

The following table lists further useful links on SAP Service Marketplace:

Table 5
Information about creating error messages service.sap.com/messages
SAP Notes search service.sap.com/notes
SAP Software Distribution Center (software download and service.sap.com/swdc

ordering of software)

SAP Online Knowledge Products (OKPs) role-specific service.sap.com/rkt-epm
Learning Maps

1.5 SAP Notes for the Upgrade

Table 6
1905391 Central Note for SAP Strategy Management | Describes how to get started with
10.1 downloading SAP Strategy Management 10.1
1911198 Restrictions Note for SAP Strategy Describes any limitations of the release
Management 10.1
CUSTOMER
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2 Quick Guide for Upgrading within the 10.1
Series

This guide shows the steps for upgrading from version 10.1 to the latest 10.1 support package.

Preparation
Table7
Section in This Guide Activity
31 Obtain the latest strategy management 10.1 installation.

Obtaining the Strategy
Management
Downloads [page 11]

3.2 Back up the Application Server databases and custom files.

Backing Up Application Server
Files [page 11]

33 Record application definitions for scheduled tasks and bookmarks.

Recording Application Definitions
That Are Not Upgraded [page 12]

3.4 Export performance management scorecard data and model connections from the
Exporting Performance existing 10.1 version using the Transporter utility.

Management Scorecard This is performed for backup purposes only.

Data [page 12]

35 Export roles and actions in SAP NetWeaver. This is performed for backup purposes only.

Exporting Roles and
Actions [page 13]

3.6 Stopping Services [page 13] Stop strategy management services.

3.7 Uninstall Application Server. Perform this step only if it is included in the latest 10.1
Uninstalling Application series. If it is not included, it means there are no changes to the Application Server in the
Server [page 13] latest release and you can continue to use your existing version.

3.8 Clean up cache files and Work databases.

Cleaning Up Files [page 14]

Upgrade Process

Table 8
Section Activity
‘ 4.1 ‘ Install the latest version of SAP Strategy Management 10.1. ‘
CUSTOMER
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Installing Application Server and
Supporting Files [page 15]

4.2 Deploy the POASBC component.

Deploying the POASBC Perform this step only if it is included in the latest 10.1 series. If it is not included, it

Component [page 18] means that there are no changes to the component in the latest release and you can
continue to use your existing version of the component.

43 Deploy the new Software Component Archive from the latest 10.1 series.

Deploying the Software

Component Archive [page 19]

4.4

Importing Bootstrap
Data [page 19]

Import the latest 10.1 series bootstrap data using the Transporter utility. Perform this
step only if a new version of Application Server is provided in the latest release.

4.5 Restarting SAP NetWeaver
and Services [page 20]

Start strategy management services and restart SAP NetWeaver to clear all table cache.

Follow-Up Activities
Table 9

51

Merging
Customizations [page 22]

Merge customizations

Redefining Strategy Management
Objects That Were Not
Upgraded [page 22]

5.2 Copy files from the \Procs directory. Perform this step only if a new version of
Copying Files From the \Procs Application Server is provided in the latest release.

Directory [page 22]

53 Redefine strategy management objects in the latest version of strategy management

that were not included in the upgrade.
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3 Preparation

3.1 Obtaining the Strategy Management Downloads

The Central Note for SAP Strategy Management explains how to obtain the downloads for that release. Any
further support packages for a release also include SAP Notes explaining how to obtain the download for each
particular support package.

3.2 Backing Up Application Server Files

Procedure

1. If youare running Application Server on a Microsoft Windows client or Microsoft Windows server, move the
lsserver.ini file located in the Windows directory to a temporary location. By moving the file, it allows the
installation to put a new version of 1sserver. ini in the Windows directory. The new version contains the
new path information for Application Server. If you have custom entries in the 1sserver.ini, you can later
incorporate the custom entries into the new version during the upgrade process.

If you do not move 1sserver.ini and you are installing the latest version of Application Server on the same
machine as the older version, then you will need to update all directory paths in the file after the new install.

2. Backup all your Application Server databases and custom procedure files. By default the databases that you
create are located in \Program Files (x86)\SAP\SSM\ApplicationServer\home ona Microsoft
Windows server. On a Linux/UNIX server they are created in the 1ss/work£ile directory in the install
location.

3. Copy the following files from the Microsoft Windows server or Linux/UNIX server where Application server is
installed to a backup location. On a Microsoft Windows server, the files are located in \Program Files

(x86) \SAP\SSM\ApplicationServer\data.OnaLinux/UNIX server, the files are located in the 1ss
directory in the installation location.

Make note of the location of all the files that you backup. Later in the upgrade process, you will be moving
these to the corresponding directory in the new install location.

Table 10

e e ]
CGLIB Contains User-Defined Hierarchies.

MASTERDB Catalog of models, users, and other important system information.
SMREPORT Contains procedures from saved reports.

4. If you customized any files that are put down by the installation, copy those files to a backup location. For
example, if you created your own timesets in APLIB, copy APLIB to a backup location. If you are running on a
Linux/UNIX server and you added entries to any of the shell scripts created by the install, copy these shell
scripts to the backup location.

CUSTOMER
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5. If youare using the Access LSLink subsystem to retrieve data from a relational data source and you have an
lsdal.ini file, copy 1sdal.ini toabackup location.

3.3 Recording Application Definitions That Are Not Upgraded

If you want to use existing definitions for the following items in the latest version of strategy management, you
need to record the definitions.

® Scheduled tasks in the administration application. Record the definitions of the scheduled tasks and recreate
them in the latest version.

®  Bookmarks. Record the contents of your bookmarked views.

3.4 Exporting Performance Management Scorecard Data

Use the Transporter tool to export your performance management scorecard data and model connections from
the older version of strategy management to zip files.

1 Note

This step is for backup purposes only.

Prerequisites

You are the strategy management administrator.

Procedure

1. Access the Tools page by opening this URL in a browser window:
http://<nw_server>:<port>/strategy/tools
Click Transporter.

3. Toexport all data, select Include Model Connection only if 1localhost is used for the system and the user/
password information is the same on the source and target systems.

4. Click Export Database to export the strategy management application data from the SAP NetWeaver System
database.

1 Note
DO NOT apply a database filter in the export. You must export all the data.

Click Download Export to download the exported database to your local system.

Save the export to a .ZIP file and name it exportsm. zip.

CUSTOMER
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7. Openthe downloaded .zip file and sort by size. If you see any files that have a length of 0, contact technical
support and do not continue the upgrade.

3.5 Exporting Roles and Actions

This step is for backup purposes only.

Procedure

Start SAP NetWeaver.

Log on as administrator with the global password you provided when you installed SAP NetWeaver.
Click I» Configuration » Security » Identity Management 3.

From the Search Criteria dropdown, select all strategy management related roles, and click Go.

Choose Export.

o 0 A~ w D=

Copy and paste the exported list to a text file located on the server.

3.6 Stopping Services

Perform this step only if a new version of Application Server has been provided in the latest release.

Procedure

If Application Server is installed on a Microsoft Windows server, go to IF Administrative Tools » Services 3and
stop the SAP SM Listener.

If Application Server is installed on a UNIX/Linux server, log on as root and stop the Application Server TCP/IP
Listener daemon by running the following:

tldstop

3.7 Uninstalling Application Server

You can uninstall Application Server using Add or Remove Programs in the Control Panel or by running the
xSSMSrv.exe file and deselecting the components.

Perform this step only if a new version of Application Server has been provided in the latest release.
CUSTOMER
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Procedure

Application Server on Microsoft Windows servers

1

o oA W N

On the Microsoft Windows server, make sure that you are logged in with a user and password that has
administrative privileges on the server.

From the installation location, run the xssMSrv . exe file.

In the first screen, click Next.

In the next screen, deselect SM Application Server to uninstall Application Server.
Click Next.

In the final screen, click Finish.

Application Server on a Linux/UNIX server

1.

Assuming you backed up your database files, MASTERDB, and any other files that were customized, use the
rm command to remove all files at the operating system level.

If you are not reinstalling Application Server on the same system, theninthe /etc/services file, delete the
following line, where nnnn is a number such as 2001 or 8325. The number varies depending on the version of
the strategy management software you have installed:

lsserver nnnn/tcp lsserver # Application Server Client

3.8 Cleaning Up Files

You must clean up files when upgrading from a previous version of strategy management.

Perform this step only if a new version of Application Server has been provided in the latest release.

Procedure

1. Clean your browser cache on the Microsoft Windows server and on all client machines.

2. Inthe\Program Files (x86)\SAP\Strategy Management\ApplicationServer directory, if you see
any .G1D files, delete them. These are Windows-based Application Server online Help cache files that are not
deleted when upgrading strategy management. These files are created the first time you start the Windows-
based Application Server online Help. If you do not see ..GID files, it means you have not access Application
Server Help. In this case, you can skip this step.

3. Inthe\Program Files (x86)\SAP\Strategy Management\ApplicationServer\home directory,
select all the Work database files, right-click, and then choose Delete from the floating menu. Work databases
have the following filenames: <web_authentication name><model>.

4. Inthe\Program Files (x86)\SAP\Strategy Management\ApplicationServer\home directory,

14

select all the DB* files, right-click to display the floating menu, and then choose Delete.
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4 Upgrade Process

This section discusses how to upgrade any SAP Strategy Management 10.1 version to the latest support package.

Prerequisites

You have completed the tasks in the Preparation section of this guide.

4.1 Installing Application Server and Supporting Files

You can install Application Server software on a Microsoft Windows server or on a Linux/UNIX server. If you are
installing on a Linux/UNIX server, you must also install Application Server on a Microsoft Windows client.

You must also install certain supporting files at the same time you install Application Server. For sites installing on
a Windows server, you install the supporting files when you install Application Server on the Windows server. For
sites installing on a Linux/UNIX server, you install the supporting files when you install Application Server on the
Windows client.

1 Note

Perform step(s) in this section only if a new version of Application Server has been provided in the latest
release.

Prerequisites

You have decided whether to install Application Server on a Microsoft Windows server or UNIX/Linux server.
You have decided whether you need to install Application Server on a Microsoft Windows client.

For information about whether you should install Application Server on a Windows client, see the Master Guide for
SAP Strategy Management on the SAP Help Portal at help.sap.com/bosm101. Then choose System Landscape.

411 Installing Application Server on a Microsoft Windows
Server

You can install Application Server on a Microsoft Windows server and install the required supporting files at the
same time. The supporting files required for the strategy management application are bootstrap.zip and

import.zip.

CUSTOMER
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Prerequisites

You are logged into the Microsoft Windows server with a user and password that has administrative privileges on
the server.

Procedure

1. From the installation location, run the xSSMSrv<sp> <patch>-<smp-1id>.exe file.

2. Inthefirst screen, click Next.

3. Inthe next screen, select Strategy Management Server Components and click Next.

4. Inthe path screen, click Next to accept the default path. To browse for a different location, click Browse.

The default pathis C:\Program Files (x86)\SAP Strategy Management.

For information about supported Windows servers, see the Product Availability Matrix (PAM) on SAP Service
Marketplace at service.sap.com/pam. In the Strategy Management PAM, choose Operating Systems, and
then choose Application Server.

5. Inthe final screen, click Done.

6. Copy either the import.zip file orthe bootstrap.zip file fromthe \SAP Strategy Management
\InternetPub\conf directory to the \server0\temp\SSM\import directory on the SAP NetWeaver
server. In a default installation, the full path is \usr\sap\SID\J00\j2ee\cluster\server0\temp\SSM
\import.

7. If youinstalled Application Server on a Windows server 2008 R2 system, modify the security settings of the
\data and \home directories to allow Users full control.

8. If your NetWeaver system database is something other than Max DB, copy the procedures from the
corresponding <sysdb> procs directory to the procs directory. See Copying Files From the \Procs
Directory [page 22] for details.

1 Note

To cancel the installation, click Cancel in any wizard screen.

The SAP SM Listener service is started by default. This service listens for WINSOCK TCP/IP Application Server
client connections. The service validates the user's rights to log on to the server and start the data communication
process.

412 Installing Application Server on a Linux/UNIX Server

You can install Application Server on a Linux/UNIX server. The client machines running Application Server use
WINSOCK support for client/server communications to Linux/UNIX servers.

After you install Application Server on a UNIX/Linux server, you must install Application Server and supporting
files on a Windows client. For more information, see Installing Application Server and Supporting Files [external
document].
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Prerequisites

You are logged in as root on the Linux/UNIX server.

You have downloaded the SAPCAR archive file and the <sarfilename>. SAR file from SAP Service Marketplace.

Procedure

Create a directory to install Application Server.

2. Fromthe location where you downloaded the .SAR file, use the following commands to transfer the .SAR file
to the desired installation directory. Case is significant on UNIX so you need to match the exact case of the
filename.

cp <sarfilename>.SAR /<installdir>
If reading the installation location from a Microsoft Windows client, use FTP to transfer the .SAR to the /
<installdir>directory onyour Linux/UNIX machine. Be sure to transfer the file as a binary file.

3. Extract the file using the following command. Make sure you enter the exact case of the filename.
SAPCAR -xvf <sarfilename>.SAR

4. Enter the following command to perform the installation.
sh install.sh

5. Answer all the prompts about your Linux/UNIX environment to set up any environment variables required by
Application Server.

6. Atthe prompt to choose the target environment, enter the number that represents your platform of Linux or
UNIX.

7. If your NetWeaver system database is something other than Max DB, copy the procedures from the
corresponding <sysdb> procs directory to the procs directory. See Copying Files From the \Procs
Directory [page 22] for details.

1 Note

At any time while you are answering the prompts, you can type @ to quit and cancel the installation.

The system creates a directory structure under the /<installdir> directory. For the complete directory
structure, see Installed File Systems and Services [external document].

4.1.3 Installing Application Server on a Microsoft Windows
Client

You can install Application Server on a Windows client. If you install Application Server on a Linux/UNIX server,
you must also install Application Server and supporting files on a Windows client machine for the following
reasons:

®  You use the Windows client machine to connect to the back end.

For information about supported Windows clients, see the Product Availability Matrix (PAM) on SAP Service
Marketplace at service.sap.com/pam. In the Strategy Management PAM, choose Operating Systems, and
then choose Administrator Application.
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e [fyoureadindata from arelational database system, you use Application Server on the Windows client to
create a Link ID and copy it to the Linux/UNIX server. (Application Server on Linux/UNIX has no interface to
createaLinkID.)

® You need to install the supporting files that are required for the strategy management application. The
bootstrap.zipand import.zip supporting files are provided in the Application Server Windows
installation.

For more information about the system landscape, see the Master Guide for SAP Strategy Management on the
SAP Help Portal at help.sap.com/bosm101. Then choose System Landscape.

Prerequisites

You have installed Application Server on a Windows server or Linux/UNIX server.

Procedure

1. Copy the file xSSMSrv<sp> <patch>-<smp-id>.exe from the download location on the Microsoft
Windows server to the Microsoft Windows client.

From the installation location, run the xSSMSrv<sp> <patch>-<smp-id>.exe file.
In the first screen, click Next.

In the next screen, select Strategy Management Server Components and click Next.

g ~ won

In the path screen, click Next to accept the default path of C: \Program Files (x86)\SAP Strategy
Management. Or, click Browse to browse for a location. Then click Next.

In the final screen, click Done.

(For Linux/UNIX installations) Move the import.zip file or bootstrap.zip file fromthe \SAP Strategy
Management\InternetPub\conf directory on the server where you installed the supporting files to the
\server0\temp\SSM\import directory on the SAP NetWeaver server. In a default installation, the full path
is\usr\sap\<SID>\J00\j2ee\cluster\server0\temp\SSM\import.

1 Note

Move import . zip if you want the demo/sample data to be available. Otherwise, move bootstrap.zip
instead.

8. Ifyouinstalled Application Server on a Windows server 2008 R2 system, modify the security settings of the /
data and /home directories to allow Users full control.

4.2 Deploying the POASBC Component

Perform this step only if a new version of the POASBC component is included in the latest release.

Use the Software Upload Manager (SUM) tool to deploy. SUM is part of every SAP NetWeaver installation with
usage types base on AS Java.
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Procedure

Deploy the PoASBC-BUINW component. This contains the NetWeaver adapter implementation and platform
(integration tier, presentation, and business tier).

This software component contains the default NW Java-only implementation, platform, and libraries for the
platform, such as JSON, JAX-RS, CVOM. This component also contains a service to generate PDFs.

4.3 Deploying the Software Component Archive

Use the Software Upload Manager (SUM) tool to deploy the SCA over your existing SCA deployment. SUM is part
of every SAP NetWeaver installation with usage types base on AS Java.
Prerequisites

You have installed NW 730 SP1 Java or higher.

Procedure

1. Deploy the Strategy Management Software Component Archive (sca) file, which you downloaded to the SAP
NetWeaver server.

2. Restart SAP NetWeaver.

4.4 Importing Bootstrap Data

You must import bootstrap data when upgrading from any previous version of the strategy management
components.

Prerequisites

You are the strategy management administrator.

You have updated your Application Server installation as described in Installing Application Server on a Microsoft
Windows Server [page 15].

Procedure

1. Depending on your implementation as noted below, copy either the import.zip file or the bootstrap.zip
file fromthe \SAP Strategy Management\InternetPub\conf directory onthe Application Server server
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tothe \server0\temp\SSM\import directory on the SAP NetWeaver server. In a default installation, the
full pathiis \usr\sap\<SID>\J00\j2ee\cluster\server0\temp\SSM\import

1 Note

Copy bootstrap.zip if you do not want the sample data to be available or if it was on your system prior to
upgrading and is included in your exportsm. zip file. If you did not have the sample data available
previously and you want it now, move import.zip.

Access the Tools utility. To do so, open this URL in a browser window:
http://<nw_server>:<port>/strategy/tools
Click Transporter.

In the Choose a database transport file section, ensure that the Delete all data in database before the import?
dropdown list is set to No.

From the dropdown list of zip files, select the bootstrap.zip file or import. zip file you moved into the
\import directory.

Click the Import into Database button.

1 Note

In case the import fails, you can review the error log in the Log Viewer in SAP NetWeaver Administrator by
going to | SAP NetWeaver Administrator » Troubleshooting » Logs and Traces » LogViewer 3. Then choose
I Show View » Open View » System Logs and Traces 1. The physical location is at \<server

installation>\j2ee\cluster\serverO\log

4.5 Restarting SAP NetWeaver and Services

Prerequisites

You have administrative permission to restart SAP NetWeaver.

Procedure

20

Restart SAP NetWeaver to clear the table cache.
Access the Tools utility at http: //<nw_server>:<port>/strategy/tools and click JPIP Session
Monitor. Then click Restart JPIP.

If Application Server is installed on a Microsoft Windows server, go to [ Administrative Tools » Services 3 and
restart the SAP SM Listener.

If Application Server is installed on a UNIX/Linux server, log on as root and start the Application Server
TCP/IP Listener daemon. Go to the directory where Application Server is installed and run the shell script to
start the Listener. For example:

cd /opt/sap/sm/lss
Run the shell script to start the Listener:
sh tldgo
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When 1sst1d has initialized, it creates a log file called LSSTLD. LOG in the current directory, and displays the
following messages:

Ak hkhkhkhkhkhkkhkkhkhkhhhkhkhAhrhhkhhkhhhkhkhhrhhhkhkhhhkhhhrhkhkhkhkhrhhkdhhkrhkkhkhkhhrhkkhkhhrhkhhhhhkhkdxxx
lsstld: daemon initialization started at Fri May 06 08:59:15 2011

lsstld: daemon initialization completed at Fri May 06 08:59:15 2011

KA A A AR A AR A AR AR A A A A AR AR A AR A AR A A AR A A A A A A AR A AR A A A AR A A A A AR AR A A Ak A A A Ak k) K
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5 Follow-Up Activities

For information about ongoing administration of strategy management components, see the Administrator’s
Guide for SAP Strategy Management Application Server and the Administrator’s Guide for SAP Strategy
Management Interactive Publisher and Application Components on the SAP Help Portal at help.sap.com/bosm101.

1 Note

Users currently running Internet Explorer 8 as their browser must upgrade to the 9 series or above.

5.1 Merging Customizations

If you previously backed up files put down by the installation because they contained customizations, merge your
changes into the new files.

5.2 Copying Files From the \Procs Directory

In some implementations, you must copy the files from\SAP Strategy Management\InternetPub\procs
\<db> procs directory up one level into the \procs directory, replacing the MaxDB version of the same files.

As an upgrade step, you must copy the files if your implementation includes both of these items:
® Youare using SQL Server, Oracle, or DB2 as the SAP NetWeaver system database.
® You are using one or more of these features:

©  You want to look at the strategy management tables in the system database

©  You are using the Entry and Approval application

©  You are using Cube Builder (now called Model Designer)

The task of copying files up one level was performed during the initial configuration, but must be done again
during an upgrade.

For information about copying the \procs folder, see the Installation Guide for SAP Strategy Management on the
SAP Help Portal at help.sap.com/bosm101. Review the topic Setting Up Client Access to the SAP NetWeaver
System Database.

5.3 Redefining Strategy Management Objects That Were Not
Upgraded

Certain aspects of functionality are not upgraded when you install the new version of the application. You must
make changes as appropriate.
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For any objects whose definitions you recorded before uninstalling strategy management, you can now create
those objects in the latest version of strategy management.

For more information, see Recording Application Definitions That Are Not Upgraded [page 12]

Features

You must make the following changes for all that apply to your implementation:

® Goal diagram status indicators may not appear in the latest version. If this is the case, you should run the
Calculate All Scorecard Objects scheduled task to have the status indicators appear as appropriate.

® You can now recreate bookmarks in the new version by referring to the saved bookmark information.
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A Appendix

A.1 List of Documentation

The following guides are located on Service Marketplace, which you can access via the SAP Help Portal at
help.sap.com/bosm101:

® Administrator’s Guide for SAP Strategy Management Application Server

e  Administrator’s Guide for SAP Strategy Management Interactive Publisher and Application Components
® (Client Installation Guide for SAP Strategy Management Excel Add-In

e  Server Configuration Help for SAP Strategy Management
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